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History of Changes

History of Changes 0

Date Changes Reason

2011-12-09 First creation

2012-02-10 Note for using the VM2TXT feature when sending voicemails added (see page 28) CQ00190069

2012-07-10 You cannot enter a message text in the text entry field of a voice message (see step 7 on 
page 24).

CQ00202919

2014-02-10 Starting with version 9, “Lotus Notes” and “Lotus Domino” are called “IBM Notes” and “IBM 
Domino”.

2014-02-10 IBM Notes 9 and IBM Domino 9 are supported. FRN6618,
FRN7467

2015-10-13 ADDED: Note to Chapter 1 UCBE-2056
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Introduction

1  Introduction

Thank you for the decision to operate the XPR (Message Routing System) under 
Lotus Notes.

XPR for Lotus Notes extends your existing Lotus Notes application by the 
functions of an advanced unified messaging system that integrates all 
communications (telephony, e-mail, voice mail, fax and SMS) on one platform, 
thus significantly improving workstation efficiency. In addition you can extend 
every workstation by multimedia call center functions.

Using XPR with Lotus Notes has the following advantages:

• The entire message administration occurs clearly and in one place.

• Simple transmission and receipt of fax, e-mail and voice messages and 
sending of SMS messages on the familiar Lotus Notes interface.

• CTI features such as telephone journal in Lotus Notes for all telephone calls 
and simple dialing from the address book.

• Use of optiClient 130.

• Mobile access via Web to the stationary workplace telephone and to all 
messages.

• Web conferences, voice conferences and combined voice/web conferences

• Easy learning owing to integration in the familiar Lotus Notes interface.

IMPORTANT:  Do not use the features “Notes Shared Login” and “Single logon” 
on a Notes Client that is installed on an Xpressions machine.
The “Notes Shared Login” is enabled through policy configuration. If Notes 
Shared Login is configured, the “Notes Client Single Logon” feature must be 
installed and the service 'Lotus Notes single Logon' must be disabled via Start > 
Settings > Control Panel > Computer Management > Services and Applications 
> Services. The option "Log in to Notes using your operating system login" must 
also be disabled via File > Security > User Security.
For more information on this feature you can also visit the following web page: 
http://www-01.ibm.com/support/knowledgecenter/ssktmj_8.5.3/
com.ibm.help.domino.admin85.doc/h_enabling_notes_shared_login_steps.html
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1.1  Who should read this Manual?

This manual describes the use of the XPR extensions integrated in Lotus Notes 
from the user's view. All screenshots and operation paths refer to version Lotus 
Notes 6.x. The described functionality is available under the other supported 
versions of Lotus Notes and IBM Notes as well. Refer to the OpenScape 
Xpresssions Release Notice for details about the supported versions.

NOTE:  The products Lotus Notes and Lotus Domino are called IBM Notes and 
IBM Domino starting with version 9.

Information on the structure and administration of the XPR system with Lotus 
Notes are described in a separate administrator manual.
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1.2  General Notes for this Manual

1.2.1  Manual Structure

The manual is divided into the following sections:

• Introductory chapter with general notes on the product and on how to use the 
manual (current chapter).

• Instructions on how to use the Lotus Notes Mail extensions when using Lotus 
Notes R6.x (from Chapter 2).

• Instructions on how to use the conferences (from Chapter 3)

• Description of the user-defined setting options when using Lotus Notes R6.x 
(from Chapter 4).

• Appendix for using web conferences (from Chapter A, “Web Conference 
Client”)

1.3  Document Conventions

The product name OpenScape Xpressions is abbreviated by XPR in this manual. 

The following conventions are used in the manual to clearly distinguish the 
various types of information.

1. Single operating instruction steps are numbered.

• Enumerations are indicated with dots.

NOTE:  A note in inserted in the text to draw your attention to a feature or to 
provide information that facilitates working with the program.

IMPORTANT:  Signals information of high priority. The corresponding details 
must be heeded to avoid damages to the system or loss of data.

Indications of operating controls, such as buttons and window captions, are 
emphasized in boldface, for example, Login Options.
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1.4  Acronym Directory

Acronyms Description

APL Access Protocol Layer

CTI Computer Telephony Integration

The following table lists the acronyms used in alphabetic sequence.
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Using Lotus Notes Mail Extensions with Lotus Notes 6.x

2  Using Lotus Notes Mail Extensions with Lotus Notes 6.x

The Lotus Notes Mail extensions are provided with the Lotus Notes e-mail client. 
If you open the e-mail client, you can select the desired mail extension via the 
menu Create > Unified Messaging for

• Fax (mail extension to send fax messages),

• Fax On Demand (mail extension to poll fax messages),

• SMS (mail extension to send short messages) or

• Voice (mail extension for sending voice messages).
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2.1  Requirements

IMPORTANT:  Lotus Notes offers an archiving option for cleaning up the mail 
database and releasing memory not used yet. If you use this option please be 
sure to execute the ensuing steps.

When archiving is active, execute the following steps:

1. Open the mail database.

2. Select in the menu Actions > Archive > Settings....

The Archive Settings dialog opens.

Select a criterion and click on the Edit button.
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3. The Edit Archive Criteria dialog opens.

Click on the Selection Criteria... button.

4. The Archive Selection Criteria dialog opens.

a) Activate the Only in these views and folders radio button.

IMPORTANT:  It is important that you activate this radio button. Do not 
activate the In all views or folders radio button, because your person 
document in your user database will be deleted then.

b) Select the views and folders to be searched for documents to be archived.

IMPORTANT:  You must no select the Unified Messaging view if it is 
available.
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5. Execute step 3 on page 13 to step 4 on page 13 for criteria shown in the dialog 
in step 2 on page 12.

2.2  Sending Fax Messages

To send a fax message proceed as follows:

1. Start the Lotus Notes e-mail client.

2. Select New Fax in the Create > Unified Messaging menu. The mail 
extension for fax message transmission is subsequently opened in a new 
window.

3. To select a recipient click the Address button. The address book opens.

4. Select a recipient form the list on the left hand side in the address book and 
click the To button. The selected entry is copied to the Recipient list on the 
right hand side of the address book.
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5. Via the buttons CC and BCC you may optionally select recipients who are to 
receive a CC copy or a BCC copy of the fax message. This copy will then be 
delivered to the recipients as Lotus Notes mail with an attached fax message 
(file attachment).

6. Confirm the selection of the recipient with OK. The address book closes.

NOTE:  Several recipients may be selected at the same time for a fax 
message.

You can also manually enter a fax number in the To: address field (if e.g. a 
recipient does not exist in the address book).

7. Enter a subject in the Subject field.

8. You can send the fax on behalf of another user. To do so, execute the 
following sub-steps:

NOTE:  The Note 'Principal' Field in Notes Mail checkbox must be 
activated for this feature to work (see administrator documentation Lotus 
Notes Gateway).

a) Click on the Display button.

b) Select Sender Information.

The From field is shown below the Subject field.

c) Click on the From link.

d) Select the user on whose behalf you wish to send the fax.

9. Enter your message in the text entry field.

10. After entering your fax message you can immediately transmit it to the 
specified recipient by enabling the Send button.

Optional settings:

The following table describes additional settings and send options that you can 
use for the transmission of the fax message.



Option Description

Icon Clicking this icon adds the following functions to the header of the 
fax send form:

• In the Display Recipient field the recipient(s) of the fax 
message is/are displayed. If you select a recipient here, his/her 
contact data is displayed in the opposite fields (if the recipient 
exists in the address book).

• In the Fax Stationery field you can select the fax stationery the 
fax message is to be sent with.

Icon Clicking this icon adds the following functions to the header of the 
fax send form:

• If the fax message is not to be sent immediately, you may set a 
send date and a send time with the option fields below Send at.

• You may set the message to High Importance and request a 
Return receipt.

Buttons Delivery 
Options
 and Tools

These buttons provide additional send parameters Lotus Notes 
supplies by default. Hints to their usage can be found in the Lotus 
Notes help.

Using Lotus Notes Mail Extensions with Lotus Notes 6.x
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2.3  Using the Lotus Notes Fax Printer Extension

The XPR Fax client component (Lotus Notes fax printer extension) enables 
sending fax messages from any application via Lotus Notes. A fax printer driver 
is therefore installed on the system, via which the created fax messages are 
transmitted to the Lotus Notes client.

After the transmission via the fax printer driver the Lotus Notes client is started 
and the fax message is displayed with a selected fax stationery. Via the Send 
button the fax message can then be sent.

In the Lotus Notes client the menu item XPR Fax is available in the Actions 
menu. By selecting this menu item a configuration dialog will be opened.

You have to enter your Lotus Notes user password in the field Authentification. 
It is used for opening the Lotus Notes client. 

IMPORTANT:  The Lotus Notes user password must also be modified in this 
dialog (e.g. after allocating a new Lotus Notes user ID)!

If you activate the option Remember Password you do not have to enter your 
password at the start of the Lotus Notes client via the  fax printer driver.

In the Send Form section you can select which fax form is to be used.
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2.4  Polling Fax Messages

With the help of the fax-on-demand feature prepared fax pages can be polled 
from a fax-on-demand service. The procedure is similar to the one described with 
fax transmission. Proceed as follows:

1. Start the Lotus Notes e-mail client.

2. In the Create > Unified Messaging menu select the Other... and then the 
Fax-on-demand menu option. The mail extension for fax message polling is 
opened in a new window.

3. To select a fax-on-demand service click the Address button. The address 
book opens.

4. Select a fax-on-demand service form the list on the left hand side in the 
address book and click the To button. The selected entry is copied to the list 
on the right hand side of the address book.

5. Confirm the selection of the recipient with OK. The address book closes. 

NOTE:  You may also enter a fax number manually in the address field To: (if 
e.g. a fax-on-demand service does not exist in the address book).

6. You can optionally enter a Subject: in the field provided.

7. Press the Send button to immediately poll the fax message.
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Optional settings:

Option Description

Icon Clicking this icon adds the following functions to the header of the 
fax-on-demand form:

• If the fax polling is not to be started immediately, you may set a 
polling date and time with the option fields below Send at.

• You may set the fax-on-demand to High importance and request 
a Return receipt.

Buttons Delivery 
Options and 
Tools

These buttons provide additional send parameters Lotus Notes 
supplies by default. Hints to their usage can be found in the Lotus 
Notes help.

The following table describes additional settings and polling options that you can 
use for polling a fax message.
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2.5  Receiving Fax Messages

NOTE:  Prerequisite for the use of the fax viewer is the installation of the ActiveX 
client components (see administration manual of the Lotus Notes Gateway).

Received fax messages are opened in a fax viewer that offers additional functions 
for editing a fax message.

You have to modify settings in your User Preferences so that the fax viewer opens 
automatically when a fax message is opened. Proceed as follows:

1. Open the dialog User Preferences via File > Preferences > User 
Preferences.

2. Select the option Use Tab to navigate Read-Only documents in the 
Additional Options list on the General tab.

3. Apply the modifications with OK. 

4. Confirm the information dialog, afterwards restart your Notes client.

If you do not configure this setting, you will receive a warning when you open a 
fax message and have to start the fax viewer manually via an icon in the message 
caption bar. If you do not want to receive this warning any more in future, you can 
deactivate it via the check box Do not show this warning again.
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The following table shows all operating elements of the fax viewer.

Menu option Description

Zoom In Enlarges the fax representation step by step. Fax enlargement 
is performed in 50 % steps referred to the basic value 
(maximum 11 steps).

Zoom Out Minimizes the fax display stepwise. Scaling down the fax is 
performed in 50 % steps with reference to the basic value 
(maximum 11 steps).

The display shows the first fax page of a multipage fax 
document (only active with multipage fax documents).

Previous Fax Page Moves back to the previous fax page in a multipage fax 
document (only active with multipage fax documents).

Next Fax Page Moves forward to the next fax page in a multipage fax 
document (only active with multipage fax documents).

Last Fax Page Skips to the final fax page in a multipage fax document (only 
active with multipage fax documents).

Fit to Width Adjusts the fax to the size of the currently opened window.

Fit whole Page The fax message is displayed as a complete page. The display 
is independent of the size of the display window.

Turn over Rotates the fax by 180°.

Turn right Rotates the fax by 90° clockwise.

Rotates the fax by 90° anti-clockwise.

Print Prints the fax document.

First Fax Page

Turn left
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2.6  Sending SMS Messages

How to send an SMS message:

1. Start the Lotus Notes e-mail client.

2. Select New SMS in the Create > Unified Messaging menu. The mail 
extension for SMS message transmission is opened in a new window.

3. To select a recipient click the Address button. The address book opens.

4. Select a recipient form the list on the left hand side in the address book and 
click the To button. The selected entry is copied to the list on the right hand 
side of the address book.

5. Via the buttons CC and BCC you may optionally select recipients who are to 
receive a CC copy or a BCC copy of the SMS message. This copy will be 
delivered as Lotus Notes mail to the recipients.

6. Confirm the selection of the recipient with OK. The address book closes. 

NOTE:  Several recipients may be selected at the same time for an SMS 
message.
You can also manually enter an SMS number in the To: address field (if e.g. 
a recipient does not exist in the address book).

7. Enter your message in the text entry field.

8. After entering your SMS message you can immediately transmit it to the 
specified recipient by enabling the Send button.

Optional settings:

The following table describes additional settings and send options that you can 
use for the transmission of the SMS message.



Option Description

Icon Clicking this icon adds the following functions to the header of the SMS 
send form:

• The Characters Left display shows how many characters are left 
for an SMS text.

• If the SMS message is not to be sent immediately, you may set a 
send date and a send time with the option fields below Send at.

• You may set the SMS message to High Importance and request a 
Return receipt.

Buttons 
Delivery 
Options and 
Tools

These buttons provide additional send parameters Lotus Notes 
supplies by default. Hints to their usage can be found in the Lotus 
Notes help.
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2.7  Voice Messages

2.7.1  Sending a Voice Message

How to send a voice message:

1. Start the Lotus Notes e-mail client.

2. Select New Voicemail in the Create > Unified Messaging menu. The mail 
extension for voice message transmission opens.

3. To select a recipient click the Address button. The address book opens.

4. Select a recipient form the list on the left hand side in the address book and 
click the To button. The selected entry is copied to the list on the right hand 
side of the address book.

5. Via the buttons CC and BCC you may optionally select recipients who are to 
receive a CC copy or a BCC copy of the voice message. This copy will then 
be delivered to the recipients as Lotus Notes mail with an attached voice 
message (file attachment).

6. Confirm the selection of the recipient with OK. The address book closes. 

NOTE:  Several recipients may be selected at the same time for a voice 
message.
You can also manually enter a recipient address in the To: address field (if 
e.g. a recipient does not exist in the address book).

7. You cannot enter a message text in the text entry field of a voice message.
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8. Under the text entry field you find the voice message operating unit that 
provides the following functions:

Function Description

Recording a 
message via 
telephone

Icon to record a voice message via telephone.
Note: A voice message can only be recorded via the individual 
workstation telephone (My Telephone Number) if the telephone 
is controlled from this graphic user interface.

Recording a 
message via 
microphone

With integrated sound card and attached microphone a voice 
message can be recorded by clicking this icon.

9. Start recording with one of the buttons described above and record your 
message.

10. Finish recording a voice message via the Stop button.
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11. After having successfully recorded a message you can use the following 
operating elements:

Function Description

Playback via 
Telephone

Voice message playback via telephone
No matter which medium you employ to play back the 
message, Position displays your current position in the tone 
document (in relation to the entire recording time). The whole 
duration as well as the temporal position and the current 
status of the playback procedure is displayed in the window’s 
status portion (under the operating elements).

Note: A voice message can only be played via the individual 
workstation telephone (My Telephone Number) if the 
telephone is controlled from this graphic user interface.

Playback via 
Soundcard

Voice message playback via the PC’s soundcard. The 
prerequisite is a soundcard implemented in the PC with 
attached loudspeakers.

Position slider Moving the Position slider with the mouse enables you to 
skip to an estimated position in the voice message. By 
means of the Position and Length status displays you can 
relatively precisely head for a certain position in the 
message.

Stop Stops message playback and skips to the start of the 
message.

Pause Interrupts voice message playback. To continue press one of 
the two playback icons.

Skip to the beginning 
of the message

This icon is used to get back to the start of the message after 
playback was interrupted or completely accomplished.

Skip to the end of the 
message

With this icon you may quickly skip to the end of the message 
(e.g. if you would like to attach a voice comment).
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12. Press the Send button to immediately start voice message transmission.

Enabling this icon opens the Options window in which some 
voice mail playback parameters can be altered.

Telephone number: This entry line displays your telephone number provided 
you have a telephone at your workstation and the telephony 
functions are installed.

Local telephone 
number:

In this entry field you may specify the telephone number of 
a connection only temporarily used.

Play voice mails on This option allows switching to the telephone intended for 
voice message playback. You can either listen to the mail by 
means of your individual workstation telephone (telephone 
number) or you can put out the message via the device that 
you have specified under Local telephone.

Note: A voice message can only be played via the individual 
workstation telephone (My Telephone Number) if the 
telephone is controlled from this graphic user interface.

Voicemail format Via the combination field of the voice format you can enter 
the coding for ISDN voice messages of your country. In 
Europe A-Law, in the U.S. mostly µ-Law is used.

If 'Browse' is pressed Here you can set the size of the steps for fast-forwarding or 
rewinding the voice message.

Function Description
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Optional settings:

Option Description

Icon Clicking this icon adds the following functions to the header of the voice 
send form:

• The option Use Number Lookup controls whether the message is to 
be sent via the XPR server (activated) or as a Lotus Notes message 
(deactivated). If the option is activated, a selection window is 
displayed. Here you can select a phone number as address for the 
message that is to be sent.
– IMPORTANT: If you want to use the VM2TXT feature (voicemail to 

text), you must activate the option Use Number Lookup and select 
a phone number in the displayed window.

• If the voice mail is not to be sent immediately, you may set a send date 
and a send time with the option fields below Send at.

• You may set the voice message to High Importance and request a 
Return receipt.

Buttons 
Delivery 
Options and 
Tools

These buttons provide additional send parameters Lotus Notes supplies 
by default. Hints to their usage can be found in the Lotus Notes help.

The following table describes additional settings and polling options that you can 
use for retrieving a voice message.
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2.7.2  Voice Message received

Received voice mails are opened in a window where you can use additional 
functions for playing them. 

NOTE:  If you are in a VPIM environment, you will receive two voice mails. One 
of them includes the originator name, the other one the actual message. XPR 
links these two voice mails to one single voice mail you may listen to.

The message view is divided into two parts when the voice message is opened. 
In the top half the received message is inserted as mail attachment. With a right-
click on the mail attachment you can open the voice message in an external 
sound playback program (e.g. Microsoft MediaPlayer).

If you click the link Show Voice Player in the message header, a voice mail 
operating area is displayed in the bottom half of the message view.
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With the help of this operating section you can listen to the received message. 
The operation is described in Section 2.7.1, “Sending a Voice Message”, on page 
24. 

NOTE:  Prerequisite for playback of a voice message via the voice message 
operating section is the installation of the ActiveX client components (see 
administration manual of the Lotus Notes Gateway).

NOTE:  If you want to control a telephone from this graphic user interface to play 
a voice message, you can only use the individual workstation telephone (My 
Telephone Number) for this purpose.
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2.8  Answering and forwarding received Messages

All received messages can be answered and forwarded using the Lotus Notes 
mail extensions. Depending on the configuration of the mail extension the 
following reply and forward options are available for all Unified Messaging 
message types:

• Reply

• Reply with log

• Forward

• Reply to all

• Reply to all with log

NOTE:  Information on the respective reply and forward options can also be 
found in the Lotus Notes help.

To reply to or forward a received message you need to select it in the inbox and 
choose the desired option in the Create > Unified Messaging respectively 
Create > Unified Messaging > Other... menu.

A new message form opens. Here you can create the message as described in 
Section 2.2, “Sending Fax Messages”, on page 14 to Section 2.7, “Voice 
Messages”, on page 24.
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2.9  Sending Messages without Mail Extensions

If the Lotus Notes mail extensions are not installed in your Lotus Notes system, 
you can also send your messages using the standard Lotus Notes e-mail client. 
Instead of an e-mail address you need to enter a special address format (XPR 
Lotus Notes address) in the To: address line for this purpose.

2.9.1  Structure of an XPR Lotus Notes Address

An XPR Lotus Notes address establishes the connection between the Lotus-
Notes-e-mail system and the XPR system. In order to enable sending messages 
with different formats (e.g.fax, SMS) from Lotus Notes to the XPR system, Lotus 
Notes addresses the XPR via a so-called foreign domain.

An XPR Lotus Notes address must thus be structured in a way that in addition to 
the user information (user name or telephone number) the name of the message 
format used and the foreign domain name are contained. The following address 
format is used:

<User>@<Message Format>@<Foreign Domain>

In the “User” address portion enter a unique user information such as a telephone 
or fax number. As "message format" the following services are available with the 
XPR:

• FAXG3 (analogue fax), 

• FAXG4 (digital fax),

• FAXG3REV (fax polling),

• SMS (short messages) and

• VOICE (voice messages).

The name of the “Foreign Domain“ differs depending on the installation. Ask your 
system administrator for the domain name.
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2.9.2  Sending Messages with the Lotus Notes 
e-mail Client

This chapter explains on the basis of an example how you can send messages 
using the XPR Lotus Notes address.

Example: Sending messages with XPR Lotus Notes address 

You would like to send a fax message to the user John Q. Public via your 
Lotus Notes e-mail client. Mr John Q. Public has the fax number 02404/
123456. Since a fax message is to be sent, FAXG3 is used as message 
format. The foreign domain is called NOTESGATE. Proceed as follows:

1. Start the Lotus Notes e-mail client.

2. Press the New Memo button to generate a new message.

3. Enter the following address in the To: field:

02404123456@FAXG3@NOTESGATE

4. Type your message and then click the Send button to start sending the 
message immediately.
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2.10  Computer Telephony Integration (CTI)

The term CTI comprises all functions that enable a logical linking of data and 
telephone services. The key to this is the connection of a computer workstation 
to a telephone. A simple case of a CTI application can be e.g. starting a defined 
PC application when a call arrives at the telephone terminal device. This can be 
extended at will, so that an incoming call can be linked to more complex, 
computer-based workflows, for example reading caller-specific information out of 
a database with subsequent preparation and representation. 

CTI works the other way round just as well. A good example is the setup of a 
communication connection to a telephone user from a computer application. The 
most simple form of such an application is a so-called dialer, which establishes a 
phone connection with the entered number at the push of a button.

2.10.1  CTI Functions

CTI provides different features for controlling and monitoring PBX systems and 
telephone devices. The most important ones are: 

• Control of telephone devices (accept call, establish connection, show display 
information etc.)

• Control of telecommunication connections (initiating connection setup, 
conferences, “park calls”, “alternate” etc.)

• Creation of CTI journals, to provide a complete telephone activities list.

Two options are available for using CTI features:

• SimpleDialer 

• optiClient 130
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2.10.2  SimpleDialer

The SimpleDialer offers the option to establish a connection via telephone under 
Lotus Notes. 

If the dialer in Lotus Notes is started, you first need to enter the phone number of 
the conversational partner and then click the Dial button. With the Pers. Address 
Book respectively Public Address Book button you can select a conversational 
partner from a Lotus Notes address book.

Now a Lotus Notes mail with the connection request data (phone numbers of the 
originator and recipient) is sent to the Lotus Notes APL. The Lotus Notes APL 
forwards this connection request to the CTI Light script. The script processes the 
connection request and starts the connection setup.

During the setup of the conversation connection first the originator is called. If the 
originator picks up the receiver, the script calls the recipient. After the recipient 
has also picked up his receiver, the two conversation partners are switched 
together.

Because of the aspect that the connection request is sent via Lotus Notes mail, 
the connection setup may take some time. Therefore, this type of connection 
setup is most suitable for intranet connections. Features such as hold, 
consultation calls, alternate and conference are not possible with the 
SimpleDialer. The conversation is finished simply by putting down the receiver.



Using Lotus Notes Mail Extensions with Lotus Notes 6.x

Erweiterungen_6x.fm

Computer Telephony Integration (CTI)

 A31003-S2370-U103-5-7619, 10/2015
36 OpenScape Xpressions V7 IBM Notes Extensions, User Guide

         

2.10.3  optiClient 130

optiClient 130 is based on Lotus Notes and extends or uses its functionality.

The most important functions are listed below. 

• Logging calls
A call dialog opens automatically for each inbound and outbound call. The call 
dialog contains the date and time of the call as well as the name of the calling/
called party or the phone number. You can enter notes for each call. You can 
specify whether a journal item and/or a task are to be created in Lotus Notes 
for each call. 

• Initiating calls via Lotus Notes
optiClient 130 enables you to initiate calls from within Lotus Notes. Select a 
contact, journal entry, task, e-mail or an appointment and push the  icon 
in the toolbar.

• Accepting calls
optiClient 130 enables you to accept calls that arrive at your telephone. This 
is not possible for other telephones.

• Switching telephone conferences

• Using convenient telephony functions
You have access to typical telephony functions such as alternate, conference, 
forwarding, etc. 

• Managing List of missed calls
If the caller hangs up without you having accepted the call, optiClient 130 
closes the call dialog again and generates a task item. The last six calls of 
that type are also displayed in the Missed calls context menu linked to the 
telephone icon so that you can directly initiate a callback. You can also 
generate a journal item instead of a task item. 

• Picked up calls: Sending notification
If you pick up a call that was directed to another user (telephone system group 
function or call forwarding), optiClient 130 opens a call dialog that displays the 
e-mail address of the originally called subscriber and the name of the caller. 
You can also generate a journal item instead of a message. 
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optiClient 130 communicates with the XPR server via LAN. Via a CTI connection 
the server controls the PBX where the telephones and the PSTN (Public 
Switched Telephone Network) are connected to.

XPR Server 

optiClient 130

PSTN 

LAN 

PBX 
Network 

CTI Link 

PBX 

For further information about optiClient 130 please consult the administrator 
documentation and the operating instructions of the optiClient 130.
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Conference Extensions

General Considerations

3  Conference Extensions

3.1  General Considerations

The conference extensions facilitate scheduling and monitoring conferences. 
There are the following conference types:

• Web conferences 
This type of conferences is exclusively staged using an internet connection. 
The Web Conferencing Tool is deployed for this purpose. Web conferences 
describe the collective use of programs and documents during real-time 
computer conferences. Web conferences enable the conference participants 
to display each other's desktop if allowed by the user. In this way all other 
conference participants can see the same image, knowing what everybody is 
on about. Documents and the entire desktop can also be shared for editing. 
Using the additional features you can discuss and illustrate matters. These 
additional features include, for example, the chat and whiteboard function. In 
case of web conferences the location in which the conference participants are 
situated is irrelevant. You merely need a PC with internet access and possibly 
a telephone. This ensures a high degree of flexibility and saves expenses for 
long journeys, accommodation etc. Since all session data is transmitted 
encrypted (256-Bit-AES encryption), sensitive data can be transmitted as 
well. 

• Voice conferences 
This type of conferences is exclusively staged via telephone.

• Combined voice/web conference 
In case of this conference type, a voice conference is staged simultaneously 
to a web conference. It is thus a web conference with additional voice 
connection.

• Monitoring a scheduled and initiated telephone conference via the 
OpenScape Web Client. 

NOTE:  The administrator can use privileges to deny you deploying conference 
features. In this case you receive a corresponding message.

NOTE:  Please remember to inform conference participants who do not have an 
e-mail address about the conference data by other means of communication.
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3.2  Setting up a Conference

1. Open your mailbox.

2. Click the Mail button.

3. In the menu select Switch to Calendar.
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4. Click the Schedule a meeting button.

5. Enter a subject for the conference in the Subject field.

6. In the Starts field specify the date and start time of the conference.

7. In the Ends field specify the date and end time of the conference.

8. In the Required (to) field enter the names of the persons who you want to 
invite for the conference.

9. In the Optional (cc) field enter the names of the persons who you want to 
optionally invite for the conference.

10. Click on the Conference button and select Create Conference in the menu.

If an error message appears, saying that no connection to the conference 
server can be established, check whether the XPR Service Provider 
Service(MspSvc) operates.
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Select the desired conference type and click on OK.

11. Depending on the conference type, properties are automatically entered in 
the conference entry:

• Web conference

– URL: Doubleclick this URL for joining the web conference.

• Voice conference

– Conference type

– Time of creation

– Voice conference PIN: With this PIN you authenticate yourself as 
conference member.

– Voice conference bridge number: This is the phone number under 
which you can log on to the conference.

• combined voice/web conference

For a combined voice/web conference all points of a voice conference 
and all points of a web conference are entered.
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12. Click on the Save and Send Invitations button.

The conference document is closed and displayed in the calendar.

13. A user invited for a conference can see the invitation with the  icon in the 
inbox. This mail contains the conference properties.

14. The invited user can accept the invitation with a click on the Respond button 
and selecting the Accept menu option.

15. The accepted invitation appears in the inbox of the invited user with the  
icon.

16. The accepted invitation appears in the inbox of the conference creator with 
the  icon.

17. Please obtain from Appendix A, “Web Conference Client” how to operate a 
web conference. You join a web conference by entering the web address of 
the client (see step 11 on page 42) in a browser.
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3.3  Editing a Conference

1. Open your mailbox.

2. Click the Mail button.

3. In the menu select Switch to Calendar.

4. Open the conference entry you want to modify.

5. Customize the conference entry.

6. Click on the Conference button and select Update Conference in the menu.

7. Here you select the conference type, which need not be identical with the 
current conference type, and click on OK.

The current conference properties are added under the previous conference 
properties.

8. Click on the Save and Send Invitations button.

If you have changed the conference time, the following dialog appears.

Click on No if you do not want to attach comments to the message.

9. Each user invited for the conference receives a mail with information about 
the conference update, indicated by the  icon in the inbox.

10. If the conference has been rescheduled, each invited user receives a mail 
with information about the conference update, indicated by the following  
icon in the inbox:
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11. If the invited user wants to accept the modification, he/she clicks on the 
Respond button and selects the Accept menu option.

12. The accepted modification appears in the inbox of the conference creator with 
the  icon.

3.4  Deleting a Conference

1. Open your mailbox.

2. Click the Mail button.

3. In the menu select Switch to Calendar.

4. Click with the right mousebutton on the conference to be deleted.

5. Select the menu option Delete.

With a click on OK you delete the conference document. A callback will then 
be created and the conference is automatically deleted in the XPR.

Click the OK button.

6. Each user invited for the conference receives a mail indicated with the  icon 
in the inbox.
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3.5  Configuration of a Conference

1. Open your mailbox.

2. Click the Mail button.

3. In the menu select Switch to Calendar.

4. Open the conference entry.

5. Click on the Conference button and select the Configure Conference 
respectively Floor Control menu option.

6. A browser with the current conference data opens.

3.6  Calling into a Conference

IMPORTANT:  You can only call into a conference if the OpenScape Web Client 
is installed and started.

NOTE:  A voice conference is started five minutes before the scheduled 
conference start. This is to stop conference participants from dialing into the voice 
conference before the scheduled start.

1. Open your mailbox.

2. Click the Mail button.

3. In the menu select Switch to Calendar.

4. Open the voice conference or voice/web conference entry.

5. Click on the Conference button and select the Call Into Conference menu 
option.

The phone number of the conference bridge is called.

NOTE:  In an ongoing voice conference you can click on the Call Control 
option in the conference menu to open the OpenScape Web Client. You can 
then lock the conference, mute participants, remove participants etc.

6. If a web conference is to be started as well, doubleclick the URL in the 
invitation text (see step 11 on page 42). You need not enter a session ID or 
password. 
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3.7  Starting a Web Conference

Only the creator of a web conference can start it. He/she needs to click on the 
Start Web Conference button after the scheduled web conference start. This 
button is not yet visible if the web conference creator opens the conference entry 
before the scheduled web conference start. Close the entry and reopen it after 
the scheduled web conference start.

3.8  Conference Overview

Click in the Lotus Notes toolbar on the following icon to open the conference 
overview:

Via this button you immediately reach the Conferences dialog of the OpenScape 
Web Client. In this dialog you receive an overview of all scheduled telephone 
conferences. 

NOTE:  In this dialog you can view the conferences but you cannot edit or delete 
them.

You find operating instructions for web conference tool in Appendix A, “Web 
Conference Client”.
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Settings for CTI and Unified Messaging with Lotus Notes 6.x

4  Settings for CTI and Unified Messaging with Lotus Notes 
6.x

In the folder Tools > Unified Messaging diverse parameters for the Unified 
Messaging features can be set in the Lotus Notes e-mail client.

In the Unified Messaging folder is a copy of your person document that exists in 
the XPR administration database. You can open your person document via the 
Settings button.

In the Logging folder a logging document is stored that logs all activities in your 
mail database and your person document. The logging scope can be configured 
(see Section 4.1, “Logging”, on page 57). A double-click on a logging document 
opens it for viewing. 

NOTE:  Your system administrator determines in the XPR administration 
database which parameters you may edit in your person document. Therefore, it 
is possible that you cannot modify all the parameters described here.

NOTE:  You need to have administrator privileges for displaying CTI settings.
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4.1  Change Unified Messaging Settings

In the open person document the Basics, Standard Messaging and Logging 
tabs are displayed. The following parameters can be set in these tabs, provided 
that the system administrator authorized you to. 

NOTE:  An icon next to the parameter shows whether you are authorized to 
change this parameter. A green tick means you are allowed to modify the 
parameter. A red cross means you are not authorized to modify this parameter.
If no icon is displayed in front of a parameter, the parameter may never be 
modified.

Basics

The Basics tab serves exclusively for your information. No settings can be 
changed here.
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Standard Messaging > Basics

Option Description

Telephone Here you can set the phone number under which you can be reached.

Unified Messaging Options area:
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Standard Messaging > Fax Cover Page > Cover Page

Option Description

Active fax cover 
type

Here you can select which fax cover page you would like to use 
for your fax messages.
• No Fax Cover Page
• Standard Fax Cover Page

One or several fax cover pages the XPRsystem provides.
• Lotus Notes Fax Cover Page

One or several fax cover pages Lotus Notes provides.

Stationery Depending on the selected Fax cover type you can set the name 
of the stationery that is to be used here.

Active Fax Cover Page area:
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Standard Messaging > Fax Cover Page > Originator

Option Description

Send answer to : If you want to send the send notification or the error report to an 
address other than the originator address, you can enter it here.

In the fields of the Originator tab user information is stored that is set in the 
corresponding fields of the XPR send form and are thus available for the fax cover 
page. Fields: Name, Company, Department, Address line 1, Address line 2, 
Zip, City,State, Country and Keyword.

Reply Address area:
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Standard Messaging > Address Book Search

Option Description

Complete Person Search: Activates or deactivates the search for additional 
recipient information in all configured address books 
(e.g. Lotus Domino directory).

Address Book Search area:
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Integrated Messaging

Option Description

Inbox replication Shows whether the inbox replication is activated or 
deactivated for this user data record.

Replicated forms All Lotus Notes forms listed here are considered in the 
Integrated Messaging context. This setting concerns the XPR 
dispatcher agent functionality in the user's mail database.

Only documents containing one of the listed form names in the 
'form' field are replicated to the XPR server. Via the Add 
Default button the default values can be loaded. The default 
values are: Memo, cyMemo, cyReply.

Replicate documents 
without form:

With this option you can determine whether documents can be 
replicated to the XPR server with or without Lotus Notes form.

Replicate all 
attachments:

Activates / Deactivates replicating mail attachments in 
messages.

Replicate only 
attachments smaller 
than (kilobyte):

Definition of the file size for mail attachments to be replicated.

Add notification for 
removed attachments:

Inserts a notification about the removal of a mail attachment 
into a received message.

Process UM messages 
only:

Determines whether all messages or only Unified Messaging 
messages are to be replicated.

Basics area:
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Computer Telephony Integration (CTI)

NOTE:  You need to have administrator privileges for displaying CTI settings.

Basics tab

Option Description

Incoming calls Successful: Yes /No
Not successful: Yes /No

Outgoing calls Successful: Yes /No
Not successful: Yes /No

On this tab you can perform settings for the CTI journal mails.

Journal area

In the header section of the tab you can disable the transmission of call 
information with the Not active option respectively activate it with the For All 
Calls option.

According to the settings chosen, further settings for the information to convey 
can be configured in the following fields.
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Logging

Option Description

Target: • Document in Database
A logging document is created and stored in the XPR 
administration database.

• Status Line
Logging output is logged in the status line. No logging document 
is created.

Document type If Document in Database has been selected as the target, you may 
determine here if a logging document is to be created per Action or 
per Person. You may also create one document for all.

Logging area:

Via the option Set Standard all entry fields can be preset with default settings. 
The link ...from performs default logging. The error messages (Fatal Error and 
Error) are logged in the status line. The link ...to performs default logging The 
Error messages, Warnings and Infos are logged in a logging document.

In the Error and Info section you can determine for which error and info types a 
logging entry shall be created.

Option Description

Fatal error A fatal error that normally finishes the execution of a program. 
Logging this error type cannot be deactivated.

Error A program error that does, however, not lead to its immediate 
closing. Logging this error type cannot be deactivated.

Warning A critical program situation that does not directly lead to an error 
but could cause an error later on. Warnings can be hints for 
following errors.



Settings for CTI and Unified Messaging with Lotus Notes 6.x

Einstellungen_6x.fm

Change Unified Messaging Settings

 A31003-S2370-U103-5-7619, 10/2015
58 OpenScape Xpressions V7 IBM Notes Extensions, User Guide

         

In the Message Box area you can set which error types are to be displayed in a 
message window. The message window then shows a system message in 
English.

The Document Size area can only be configured when you have set Document 
in Database as output target.

In the Debugging area you can determine debug outputs in four steps.

Info Normal program states are logged.

Enter/Exit Logs the program stack. E.g. entering a sub-function logs an 
enter message. This logging option can be used for debugging.

Option Description

Number of items Each logging entry is inserted as rich text field in the logging 
document. Here you can set how many rich text fields the logging 
document shall have.

Bytes per item Number of bytes that are to be used per logging entry. The 
minimum is 500 bytes.

History capacity Shows the minimum and maximum capacity of a logging 
document in kilobyte.

Option Description
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Web Conference Client

A  Web Conference Client

You find information about the Web Conference Client in the OpenScape Web 
Collaboration user guide.
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